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@ Workshop

o Interactive!

o Copy the sample files from the USB thumb drive:

4 . KINGSTON (E:)
4 | (CloudCompare_workshop_CICESE

| binaries

| data
> 1 LAStools_workshop_CICESE.zip
> 1 PULSEtools.zip

o You can install CloudCompare 2.6.1 with the Windows or
Mac OS X 10.9+ installers (“binaries”). Otherwise go to:

www.cloudcompare.org



http://www.cloudcompare.org/

@ Outline

o About the project

o Generalities
Level 1: GUI, display, manual editing, etc.

o Advanced stuff
Level 2: registration, distances, scalar fields, etc.

o And everything else...



(C 2003: PhD for EDF R&D

¢

& D o EDF

N main French power utility

eDF Over 150 000 employees worldwide
ROD 2 000 @ R&D (< 2%)

200 know about CloudCompare (< 0.2%)
Sales >75 Bn € (90 Bn $)
Over 200 dams
58 nuclear reactors (19 plants)




@ EDF and Laser Scanning

o EDF = former owner of Mensi (now Trimble Laser
Scanning)

o Main scanning activity: as-built documentation

Scanning a single nuclear reactor building
2002: 3 days, 50 M. points
2014: 1.5 days, 50 Bn points (+ high res. photos)



(C: EDF and Laser Scanning

o Other scanning activities:
Building monitoring (dams, cooling towers, etc.)
Landslide monitoring
Hydrology
Historical preservation (EDF Foundation)
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(C PrD

b‘-\ o Change detection on 3D geometric data

e Application to Emergency Mapping

€DF

R©D

o Inspired by 9/11 post-attacks recovery efforts
(see “Mapping Ground Zero” by J. Kern, Optech, Nov. 20017)

= B i G .

TLS was used for: visualization, optimal crane placement, measurements,
monitoring the subsidence of the wreckage pile, slurry wall monitoring, etc.



CloudCompare V1

o 2004-2006

€DF o Initial goals: to compare freshly (and big) acquired point
R@D clouds to quickly assess for changes

either between a cloud and a mesh/CAD

or directly between two clouds (= the high density of
TLS clouds is the key)




@ CloudCompare V2

o 2007: “Industrialization” of CloudCompare
... for internal use only!

o Rationale:
idle reactor = 6 M€/ day

acquired data can be checked on-site - less missing or
erroneous data > no need to come back later

checking the work of sub-contractors in charge of modeling
became fast and accurate

the algorithms are also used for clash detection during
virtual simulation of tricky maintenance operations - highly
reduces the risk of issues or bad surprises during the actual
maintenance operation

o Moreover EDF is not a software company



@ The open-source path

o 2009/2010: CloudCompare V2.1 CloudCompare”

. | & B B
Already a multi-purpose point cloud g
editing and processing software o

A

o 2014: CloudCompare V2.6

o Works on:
Windows (XP /7 /8)
Mac OS (thanks to Andy Maloney)
Linux (thanks to Romain Janvier)

o Supports 3D mice (Windows only)



@ Open-source!

o Quickly evolving

o Goes where the users want...
... goes there faster if the users are able to actively participate!

o Remains under strict supervision of the administrator ;-)
o Independent on any manufacturer

o Meant to survive: backed by strong companies and
institutions (EDF, BRGM, CNRS, etc.)



FROM NOW ON, T WANT
YOU TO USE OPEN SOURCE
SOFTWARE FOR EVERY—
THING WE DO. ITS

FREE.

| T'LL BE
/1' RIGHT
BACK. .1

o ...but someone has to “pay” ;)
either by working on the project
or by paying someone to do so

o plugins are not necessarily public or free



(c: Users Developers

o Too many ;) o Barely enough

Academics: few

remote sensing

geology

archeology

etc.
Surveyors none
Forensic experts none
Architects none
MDs, dentists none
3D designers none

Artist?! none



@ Development cycle

Specs core
P algorithm
1 [
]

A simple The less fun Developer s
message on The fun part part (
the forum User’s hell ;) }
stability

A

:\ M user feedback!

1st release

time

v



@ Worldwide users

&
A
- # ;
Mexico
Sessions: 224
B

1 T 1 832

> 1300 subscribers to the news letter



Generalities



@ User interface overview

Menus + main toolbars

@ CloudCompare - [SD View 1]

+ =

View Z
toolbar \a ||

gquumnmNo

(@ FEile

B <k

Edit Tools 3D Views

E & X S

Display  Plugins Help

Tree

‘us -PB view
a v
[¥] ® Octree
[¥] “. 2D label: Point 39788
[¥] *. 2D label: Point #27530

+/data/...

[] camera Link

Selected
entity
properties - &

Visible |
SF display params
Display ranges ] Parameters

displayed 0,31079292

v

0,00000000 g

saturation 0,10000000

[07:55:49] [BIN] Opening file 'C:\dev\CloudCompare\data\BIN\House.bin'...
[07:55:49] [BIN] Version 1.0

[07:56:20] [Algortihm] Timing: 6.55 s.

[07:56:43] [doActionComputeOctree] Timing: 0.257 s

Console



@ Input/Output ¢ =

o Mainly point clouds (ASC/PTS, LAS/LAZ, E57, PTX,
FLS/FWS, DP, etc.) and triangular meshes (PLY, OBJ,
STL, OFF, FBX)

o Dedicated format: “BIN” (for projects)

o Other formats: calibrated photos (Bundler .OUT), CAD (Autocad
DXF drawings, Aveva .PDMS scripts), GIS shapefiles

o To come:
RIEGL files
more manufacturer formats?



@ Clouds display
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(C pcv

o Global illumination / ambient occlusion

Tlluminance (PCV)
1.000000

0.909274
0.863911
0.818548
0.773185
0.727823
0.682460
0.637097
0.591734
0.546371
0.501008
0.455645
0.410282
0.364919
0.319556
0.274194

0.205645
0.137097

0.068548

0.000000




@ Scalar fields

o One value per point

o The value can be anything (distance, intensity, density,
roughness, confidence, curvature, temperature, time,

etc.)

o Values can be (dynamically) color-coded




Scalar fields

o Values can be
mixed (+,-,/,X)
transformed (cos, log, etc.)
filtered (spatial smoothing, spatial gradient, etc.)
imported or exported as a coordinate dimension
merged with colors

o Statistics can be computed

o Clouds can be processed based on those values
Segmentation (Filter by value)
Subsampling

o Values can be exported to a CSV file
(- Excel, Matlab, etc.)



Color scales

o Color Scale Editor : edit and create color scales

(I Color Sccale Editor @
Current [D - 50 cm hd ]

Mode |absulute * | |Rename | |Save [Delete] [Cepy] [New]

& a|

Selected slider

Color |'I.-'a|ue 0, 100000 1 (20 %)

o Color scales can now be imported/exported as XML files

o When saving a « BIN » file, custom scales are automatically
exported (and will be automatically imported when opening the
file on another PC)



Manual editing

O O 0O 0O 0O O O

Manual transformation
Manual segmentation
Cross Section

Color / Normal editing
Sub-sampling tool
Scaling

Cloning / Merging

(i) (O] (@)

=[x
- o @ > e > & »

B ) v] @
Segment Out




Advanced



@ Registration

o Point-pair based alignment
o Automatic registration (ICP)

@ File Edit Tools Display Plugins 3D Views Help

| Maquette_Rem_Koolhaas_cle...
Lo ) Rem_Koolhaas_house_1

) Rem_Koolhaas_house 2

Properties =

gquuEnmO o,

+ semi-automatic ball detection

_

- || & X

\@‘)w » L > @ »

[Point-pair registration]
Current RMS: 3.52894

€ o oisned cout SR

X Y z -
AD 838,89 -447,239 41,5564 =
Al 699,153 -518,193 -34,4604 i
A2 657,825 -1101,83 179,838 -
4 mn »
[7] show reference doud @

RO 102574
R1 8483835
R2 655,064
r

X

Y
-564,348
-561,234
-1140,79

1

59,1903
64,0873
-34,5801 -

[ auto update zoom [V¥] fixed scale

(o) ) @) ()




(c: Registration
Some considerations
What if my entities have some “structural
differences”?

o Small local differences:
|ICP: ‘Enable farthest points removal’ checkbox

o Different scales:

Point-pairs based alignment: uncheck the ‘Fixed
scale’ checkbox

ICP: check the ‘Free scale parameters’ checkbox

o Major differences:
Prefer the “point-pairs based alignment” tool!



@ Registration
Some (more) consideratio

What if one of the entity is a mesh?
o Almost the same workflow

o Sometimes you may have to

sample points on the mesh first (Edit > Mesh >
Sample points)

then apply the resulting transformation on the original
mesh (Edit > Apply Transformation)

o For the ICP process (fine registration) the mesh
should always be the ‘reference’

generally less holes and/or noise



O Distances computation



(C: Distances computation

o Distances are computed between each point of a
‘compared’ cloud and its nearest point or triangle in a
‘reference’ entity

e 0 O

O
® reference
cd ®

9 @

o Process is not symmetrical



@ Distances computation

Two (or three) cases

Comparison of two clouds ;=
Comparison of a cloud and a mesh ;=

Comparison of two meshes: the only way to
do this in CloudCompare Is to sample points
on the ‘compared’ mesh - back to case 2



@ Cloud-cloud distances

o Main idea: if the ‘reference’ cloud is dense enough, then the nearest
neighbor distance will be (almost) as accurate as the true distance
to the underlying surface

Error is bounded 17X _ 1
Error depends on the : /\ 2=
reference cloud density only e NAT

N

N.N. distances in a random
Poisson process

o Consequences:
Use the denser cloud as reference (if possible)

The reference cloud extents must be at least as large as the compared
ones (avoid non overlapping areas!)



(c: Poor or Irregular density?

Local meshing strategy

°
Y
°
. _________________________
measured distance Local modeling: 2to 5
=== real distance B elowar

129.6402




@ Cloud-cloud distances

o Select both entities
o Ik

.+l

((» CloudCompare v2.6.1 [64 bits] - [3D View 1] - B n
@ File Edit Tools Display Plugins 3D Views Help =]

. B =] % B a

B GE X 8

Remove filter ~ Blur (shader) E 9 9 ot M ! & 3 N:E SOR ﬁﬁ

DB Tree ) EyeDome Lighting (disa better result))

) [[] &3 cicese.bin (C:/Dev/Data/Users... : C2C absolute distances

KX || 4 [v] & GoPro14_10_17_1.az (C:/Dev/... 5.00

4 [] & GoPro14_10_17_1 - Cloudr...

& GoPro14_10_17_1 - Cloud.regis...

[] camera Link

Properties &

Property State/Value (o
Display ranges Parameters
0.00205C 3| displayed |4.9999737 %

A
C

Console

[13:09:49] [GL Filter] Filter initialized
[13:09:50] [GL Filter] Filter initialized
[13:09:51] [GL Filter] Filter initialized

@@uoenER o +M4L




Robust C2C distances with
M3C2

b M3C2 on complex topography

" Normal at scale D, affected by roughness D,
\ Normal at scale D, not affected by roughness D,

Significant

change

Missing data =
no distance calculation

-, b 8
Q.7
] 96 ﬁv\sk o o _
az(d) Overestimation of distance due to
normal misorientation at scale D1

J.UUU
-0.006
\ . ’ g v -0.014
B significant ch : ' : basal cliff erosion s 003y B
ignificant change * rockfall £ Wy -0.064
Non-significant = change : alluvial bank erosion iRy , 0140 m

2 . 0.310 &=
smaller than local LODgss, L  bed aggradation 0,640 £

: stable parts  of -1.400
: gully deposits /. -3.100
: rockfall deposits : -7.000

Lague, D., Brodu, N. and Leroux, J., Accurate 3D comparison of complex topography with
terrestrial laser scanner : application to the Rangitikei canyon (N-Z), 2013, ISPRS journal of
Photogrammmetry and Remote Sensing



http://www.sciencedirect.com/science/article/pii/S0924271613001184

@ Cloud-mesh distances

o In this mode, the distance is computed between each
point of the ‘compared’ cloud and its nearest triangle
In the ‘reference’ mesh

o If the mesh quality is good, this is generally faster and
more accurate... but getting a clean mesh can be
hard!

o Regarding the output, the only difference with the
cloud/cloud case is that the distances are signed (we
use the triangle normal)



@ Cloud-mesh distances

(T CloudCompare - [3D View 1]

< File Edit Tools Display Plugins 3D Views Help

?) B E & X o8t

DE Tree &

i 4 3 pad_gv.bin (C:/dev/CloudCompa...

O] @ pad_gv - Cloud 20

a [7] &y pad_gvl.obj(C/dev/CloudComp...
> *@' Mesh Group

- [] camera Link
@ Properties =2
Property State/Value -
Active

Color Scale

&)

Current
Steps
Visible

SF display params
Display ranges

-2488,3471€(%| displayed 1926,37158%

U 1

-1000,00000 % saturation 1000,00000 %

0 0|

Console 8 X

[20:13:18] [ObjFilter:Load] Some normals in file were invalid, You should re-compute them (select entity, then "Edit > Normals > Compute') -
[20:14:15] [ComputeApproxDistances] Time: 1.21 s,

[20:15:28] [ComputeDistances] Time: 3.73 s,

[20:15:28] [ComputeDistances] Mean distance = -6.544396 / std deviation = 113.947289




(C classification with CANUPO

Raw 3D Point Cloud Multi-Scale Dimensionality Classification

Vegetation

Rock

Brodu, N. and Lague, D., 3D Terrestrial LIDAR data classification of complex natural scenes
using a multi-scale dimensionality criterion : applications in geomorphology, ISPRS journal of
Photogrammmetry and Remote Sensing, 2012



@ Cleaning

Various methods to remove isolated parts, outliers, non-
overlapping areas, etc. :

¥ o Manual editing

¢z o Remove isolated parts with the “Label Connected
Components” tool

o Remove isolated points / noise with:
Tools > Clean > Noise filter

o Other option: scalar-field based segmentation



Contour/profile extraction

Section edition mode
Left click: add section points / Right click: stop




@ Rasterize & contour plots

E

Rasterize
Cloud
Name 5054800 _c - Cloud
Points 3886421

height range 222.84(38.73 - 261.57)

Update arid
Grid
o= T (e
size 500 x 500
Projection

cell height average height 52

[ resample input loud

Empty cells

Fill with [Ieave empty 2
0.000

Export Contour plot ‘

( Cloud ]

Export per-cell statistics as SF(s):
[7] population [*] min height
[7] average height  [] max height

[7] height std. dev. [] height range

[ Raster (geotiff) H Image

Matrix (text file)

BREmA o+

(@ CloudCompare v2.6.1.beta [64 bits] - [3D View 1] = ‘ =

@ File Edit Tools Display Plugins 3D Views Help - || &%
2, a S o o

PB GE R X St v & - L'z m+ -9~

Remove filter  Blur (shader) NoC SOR fiLs

*E

o

@aan

DB Tree

5

4 [7] &y 5054800_c - Cloud.bin (E:/These/Donne...
[¥] & 5054800_c - Cloud
[¥] & Contour plot(5054800_c - Cloud) [step=5]
[¥] $« Contour line z=43.73 (#1)
[¥] 4« Contour line z=43.73 (£2)
[¥] 4« Contour line z=48.73 (£1)
> [V] $« Contour line z=48.73 (£2)
[¥] 4« Contour line z=48.73 (#3)
[¥] $« Contour line 2=53.73 (¥1)
» [¥] $« Contour line z=53.73 (£2)
> [V] $« Contour line z=53.73 (#3)
[¥] $« Contour line z=53.73 (#4)
[¥] $« Contour line 2=53.73 (#5)
> [¥] $« Contour linez=58.73 (£1)
[V] 4« Contour line z=58.73 (£2)
= d

[N

-

PR £0 72 r22
[7] camera Link
Properties =
Property State/Value -
1
Name Contour plot(5054800_c - Clo... 1
Show name (in3D) [7]
X: 998
Box dimensions Y: 998
Z:195 Y.

Console

7[18:25:03] [Rasterize] 98 iso-lines generated (45 levels)

18:25:201 [Rasterizel 98 icn-lines nenerated (45 level<)

[18:25:18] [Rasterize] Current raster grid: size: 500 x 500 / heights: [39.1112 ; 259.917]
[18:25:18] [VBO] VBO(s) (re)initialized for cloud '5054800_c - Cloud.raster(2)' (3.58 Mb = 100.00% of points could be loaded) L

<

. | »




O Other



(C. working with SfM data

o Support for Bundler files

o Handling of calibrated pictures and
camera sSensors

= CloudCompare v2.6.1 [64 bits] - [3D View 1] - B n
@ File Edit Tools Display Plugins 3D Views Help BEIE
l&E “(‘fr-:\\\? H X i i ERCEY, 2 :': v F - 5l 5

Remove fiter  slur (shacer) [ W | @) 12 Be & S BIEL| NT SR i

DB Tree [}

Camera #4 2

> Camera #8 hd

[] camera Link

Properties a8
Property State/Value ~
Name Camera #6
Visible
Show name (... []

X:2.33116

Local box dim... Y: 2.00879
Z:2.25836
X:-1.28275
Box center Y. -11.5274

7. 1 157A1

Console

[14:14:06] [ApplylmageViewport] Viewport applied
[14:14:19] [ApplylmageViewport] Viewport applied
[14:14:40] [ApplySensorViewport] Viewport applied

E8uownomaer +PL+ = p




@ Sensors

o TLS ("GBL") Sensors

o Camera sensors

c CloudCompare v2.6.1 [64 bits] - [3D View 1] - B n

@| Eile | Edit Tools Display Plugins 3D Views Help

PEGECBEX S198 8.4 1K [ =l ok

Remove filter  Blur (shader) m 9 & 15 é?;',,.,, N+C SOR MLS
DB Tree g j%

& :

4 3 Demo.fws (C:/Dev/Data/FARO... =
= 4 < Scan_001 §
- @ Ground Based Laser Sc...

> [] & Scan_002
Ji_
¢ ;
[ camera Link
+' Properties
Q
)
&
(=
i)
‘u, Console
&m. [14:20:14] [Faro] File 'C;/Dev/Data/FARO/Demo/Demo.fws’ contains 2 scans ~
* | [[14:20:15] [Faro] Scan size: (671 x 1498) [up to 1005158 points]

[14:20:16] [Faro] Scan size: (671 x 1498) [up to 1005158 paints] v




@ Meshing

o Meshing tool (to cope with holes mainly)
Delaunay 2D for ‘2Dz’ clouds
Or the gPoissonRecon plugin for closed shapes

Warning: CloudCompare is not a ‘meshing’ tool
(remember that the initial aim was to avoid meshes ;-)

It only provides simple approaches for convenience

Consider using “true” meshing tools
(Meshlab, VR mesh, Geomagic, etc.)
If you need accurate meshes



@ Presenting & sharing results

o Analysis
Histogram
Local Statistical Testing tool
Export to Matlab®/Excel®/etc. (ASCIlI ~ CSV format)

o Display
create labels, save viewports, etc.
Save the whole project in a “BIN” file

o Share
ccViewer (lightweight, for load & display only)



@ ccViewer

© Viewer
Options

Help

E=3 Eol




@ Misc.

Plane and sphere fitting

Unroll feature (on a cylinder or a cone)
Plugins

Command line mode

Wiki (http://www.cloudcompare.org/doc/wiki)



http://www.cloudcompare.org/doc/wiki

Next



In preparation

o Near future:
Oculus Rift plugin
Animation
Volume calculation

o TODO list:
https://qithub.com/cloudcompare/trunk/blob/master/gCC/TODO.txt



https://github.com/cloudcompare/trunk/blob/master/qCC/TODO.txt

@ Next workshops

o 2nd international conference of the IAFSM (San
Diego, Nov. 2015)




Thanks for your attention!

www.cloudcompare.org

=5 - o KN

CloudCompare - Op: x

€« C f  [) www.cloudcompare.org PO N =
CloudCompare"? Want to support/help us?
<WE: ]
& CloudCompare 1.765.00 Raised!
¢or

3D point cloud and mesh processing software
Open Source Project

Home - Presentation - Download - Github - Tutorials - Documentation - Forum - Declare a bug

Welcome to the official website of the CloudCompare project.

Want to know when a new release comes out? Subscribe to the newsletter [your email address | JOIN |

PO —p— -_.'"—'1"'5“"’ © ccvemevizs = o
At Optiers  Shaders  Help

] e Upeng (bt rore = 32 roeoc poss e fr 3 bt 08

CloudCompare (view, edit and process) ccViewer (light viewer only)

First LAStools / CloudCompare Workshop in Latin America (8-10 Apr.)

New user documentation: version 2.6.1 .

CloudCompare home - danielgm.net - EDF R&D - contact


http://www.cloudcompare.org/

